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Product Summary 
The term "PowerPack emulator" refers to any PowerPack® in-circuit emulator for embedded 
system development. The terms "PP", "SW", and "EA" refer to the PowerPack PP, SW, and 
EA emulators respectively. The terms "SLD™ software", "emulator inteiface", and 
"debugger software" refer to the SLD™ source-level debugger. 

This chapter describes the emulator and debugger documentation, host system requirements, 
and how to contact Microtek International for information and technical support. 

Documentation 

Resource 

Hardware 
Reference 

User's Manual 

How to ... 

The following describes the printed and online documentation resources 
for the PowerPack emulators. The manuals in your emulator package 
are the SLD™ Source-Level Debugger User's Manual (referred to as 
the User's Manual) and the PowerPack® EA/SW In-Circuit Emulator 
Hardware Reference, referred to as the Hardware Reference and 
formerly known as the Up & Running. Other, related publications 
described at the end of this list are not included in your emulator 
package. 

Chapter Contents 

Product Summary 

Software Installation 

Parts, features, documentation, support 

Configuring your PC or workstation; 
installing the SLD software 

Hardware Installation Installing the PowerPack hardware; running 
the confidence tests 

Tutorial 

Target Hardware 

Getting Started 

Defining the Debug 
Environment 

Debugging in Source 

Debugging in 
Registers and 
Memory 

Practicing basic emulator tasks 

SAST board schematics; signals 

Host sytem requirements; contacting Microtek 

Creating a loadfile; starting and exiting the 
SLD software; configuring memory and 
registers; using an initialization file 

Viewing source code, disassembly, and stack; 
editing variables; controlling emulation 

Accessing CPU and peripheral signals and 
numeric or disassembled memory contents 
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Reference 

PowerPack 
SLD Help 

For help on using 
online help, choose 
How to Use Help from 
any SLD Help menu or 
press <F1 > twice. 

Related 
Publications 

Product Summary 

Debugging with 
Triggers and Trace 

powerpak.ini File 

Toolbar 

Shell Window 

Source Window 

Variable Window 

Breakpoint Window 

CPU Window 

Stack Window 

Memory Window 

Peripheral Window 

Trace Window 

Event Window 

Trigger Window 

Emulation and trace control using triggers; 
numeric and symbolic address formats 

powerpak.ini file· contents 

Toolbar controls 

Shell window contents, controls, commands 

Source window contents, controls 

Variable window contents, controls 

Breakpoint window contents, controls 

CPU window contents, controls 

Stack window contents, controls 

Memory window contents, controls 

Peripheral window contents, controls 

Trace window contents, controls 

Event window contents, controls 

Trigger window contents, controls 

Whether or not the emulator is active, you can invoke the SLD online 
help from within Windows. Choose the SLD Help icon (shown at left). 
SLD online help conforms to the standard Windows help interface, as 
described in your Microsoft Windows documentation. 

For help from within the SLD software, choose a Help menu item; or, 
press <Fl> at any time. In most SLD dialog and message boxes, you 
can choose a Help button for context-sensitive help. In the Shell 
window, you can list Shell command syntax with a Help command. 

Topic Resource 

Windows 3.1; Windows 95; 
Windows for Workgroups 3.11 

Your target processor 

Your toolchain and loadfile 
format 

C++ symbols 

2 

Microsoft documentation 

Your chip vendor documentation 

Your compiler, assembler, linker, 
and converter documentation 

The Annotated C++ Reference 
Manual, Margaret Ellis and Bjarne 
Stroustrup (Addison-Wesley, 1990) 
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How to Contact Microtek 

To register for technical support and ongoing product information, 
complete and mail the registration card enclosed with the emulator. 

Contact Microtek/DSD to purchase Gold Club membership. Gold Club 
provides firmware, software, and hardware updates and priority service, 
in addition to repairs. 

As a Microtek customer, you can contact Microtek technical support for 
help with an emulator problem during your warranty period. The email 
and fax lines are operational 24 hours a day, 7 days a week. 

Internet email csupport@microtekintl.com (technical support) 
info@microtekintl.com (other information) 

World Wide Web http:\\www.microtekintl.com (product news) 

Microtek/DSD, 
Western USA 

Microtek, 
Eastern USA 

Microtek, 
Hsinchu, Taiwan 

Adara 
International, 
Taipei, Taiwan 

(503) 645-7333 voice; (503) 629-8460 fax 
(voice contact available Monday through Friday, 
8:00 am to 5:00 pm USA Pacific Time) 

(610) 783-6366 voice; (610) 783-6360 fax 
(voice contact available Monday through Friday, 
8:00 am to 5:00 pm USA Eastern Time) 

+886-3-577-2155 voice; +886-3-577-2598 fax 
(voice contact available Monday through Friday, 
8:00 am to 5:00 pm Taiwan Time) 

+886-2-501-6699 voice; +886-2-505-0137 fax. 
(voice contact available Monday through Friday, 
8:00 am to 5:00 pm Taiwan Time) 

Before you call, please read the PowerPack® Emulator Problem Report 
Form in the SLD online help. 

When you call, please be at your computer with the SLD software 
running and have the emulator documentation and filled-out problem 
report form (printable from the online help) nearby. 

Emulator Parts 

When you take the emulator out of its shipping package, check to be 
sure all the following are present (see the figure following this list). 

• the emulator and probe assembly 

• optionally, an adapter for connecting the probe to the target board 

• with the EA-486 emulator only, two male-to-male PGA connectors. 
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• a stand-alone self-test (SAST) board 

• an RS-232C cable for connecting the emulator to the host system 

• a 25-pin and a 9-pin serial adapter 

• a power supply 

• a power cord 

• three SLD software program disks 

• besides this manual, the SW User's Manual and a slipcase binder 

power supply 

male-male 
PGA connectors 

(486 only) 

emulator and probe module assembly 

manual 

probe adapter 
(option) 

SLD™ program disks 

SAST board 

RS-232 cable with 
9-pin adapter 

25 pin serial 
port adapter 

power cord 

Target Adapters 

Product Summary 

When your target hardware is ready, you need an adapter to connect the 
emulator to the processor chip or socket your target board. You can 
order the adapter from Microtek with your emulator order or separately. 
The following target adapters are available: 
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386 Clip-over 
(PP-ET-132QFPCO) 

Clips over and tri-states a surface­
mountcd 386 target CPU. 

Tex tool 
(PP-ET-132SM-3M) 

Plugs into a 3Mffextool 
2-0132-07244-000-018-007 socket on 

the 386 target board. 

486 Clip-overs 
(168PGA-208CO or 

168PGA-196CO) 

Clips over and tri-states a surface­
mounted 486 target CPU. 

Emulator Features 

Amp 
(PP-ET-132SM-AMP) 

Plugs into an Amp 821949-5 socket on 
the 386 target board. 

386 solder down 
(PP-ET-132QFPSD) 

Solders to the target board in place of 
the 386 target CPU. 

486 solder downs 
(168PGA-208SD or 

168PGA-196SD) 

Solders to the target board in place of 
the 486 target CPU. 

Communication between the emulator and the host system is via RS-
232C communications at 19.2K, 38.4K, 57.6K, or 115K baud. 

The emulator automatically configures itself for 5V or 3V operation. 

Source-Level Symbolic Debugging 

The SLD™ (Source-Level Debugger) software runs as a Microsoft 
Windows 95, Windows 3.1, or Windows for Workgroups 3.11 
application with context-sensitive online help. Besides using a mouse 
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Product Summary 

or Windows-style keyboard entry with menus and buttons, you can enter 
commands via the SLD Shell window command line. 

You can open several SLD windows at once. For example, you can 
monitor variables and view the trace while debugging at the source 
level. You can view two sections of source code simultaneously in the 
Source window. You can have up to 20 different Memory windows 
open simultaneously with various numeric, ASCII, and disassembly 
views of memory. 

You can debug from the vantage of your C and assembly language 
source: 

• All symbol types are supported, including static variables, stack­
based local variables, register-based variables, structures, arrays, 
and pointers. 

• You can selectively load object code and symbolic information into 
target or overlay memory and into the symbol table, for OMF86 
and OMF386 load formats. 

• Source display formats include source and assembly language from 
your source files, disassembly from memory when the source files 
are unavailable, and disassembly from memory interleaved with the 
corresponding lines from your source files. 

You can set breakpoints on a line of source or disassembly or on a 
symbolic or numeric address: 

• 128 software breakpoints are available for the SW; 256 are 
available for the EA. 

• Up to four hardware breakpoints are available, using the debug 
registers (DR[0 . .3]). You can reserve the debug registers for use by 
your program instead of as breakpoint registers. 

• The emulator automatically chooses whether a breakpoint is set in 
hardware or in software; or you can access the debug registers to 
explicitly specify a hardware data or execution breakpoint. 

Memory and Register Access 

You can substitute IM or 4M bytes of emulator-controlled overlay 
memory for your target RAM or ROM memory. You can configure the 
overlay memory with zero or more wait states. 

You can monitor the stack, the CPU registers, the peripheral registers, 
and memory contents during emulation. 

A single-line assembler is available for patching loaded code. 

6 EA/SW Emulator Hardware Reference 



Real-Time Trace 
Real-time, full-speed tracing is optionally available: 

• You can collect 128K frames of address, data, and signal trace in 
the SW, or 256K frames in the EA. 

• You can qualify trace collection by address, data, and signal criteria 
in the EA. 

• You can display trace as instructions, as bus cycles, or (in the EA) 
as clock cycles. 

• You can link the Trace and Source windows to scroll together, to 
view the disassembled trace synchronously with the corresponding 
source lines and disassembled memory. 

• During emulation, you can start and stop trace collection without 
affecting emulation. 

• In the EA, besides manually starting and stopping trace and 
emulation, you can define up to four sequential trigger conditions 
to conditionally control emulation and trace collection. Each 
trigger is a logical combination of up to eight events, with optional 
counter and timer dependencies. An event is defined as signal 
values and inclusive, exclusive, or masked address and data ranges. 
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Software Configuration 
The terms "SLD software" and "emulator software" refer to the SLD™ source-level 
debugger for the PowerPack® emulator. 

The SLD software runs under Windows 3.1, Windows for Workgroups 3.11, and Windows 95. 

Host System Requirements and Recommendations 

• An Intel486 or Pentium based PC or 100% compatible system 

• Windows 95; or MS-DOS 5.0 or 6.x with Windows 3.1 or 
Windows for Workgroups 3.11 running in 386-enhanced mode 

• At least 8M bytes of RAM 

• At least 8M bytes of free memory after you have loaded your 
Windows interface and any other applications besides the SLD 
software. 

• At least 5M bytes of available disk space 

• A VGA or Super VGA graphics card and color monitor (a graphics 
accelerator card recommended to boost performance; a monitor 
capable of at least 800x600 operation recommended) 

• A mouse 

• A serial port for connection to the emulator (16550 UART 
recommended for operation at 57.6K baud and above) 

• At least 4M bytes for a swap file (permanent swap file 
recommended, with a disk cache such as smartdrive for improved 
Windows performance) 

• Config.sys entries of at least Files=30 and Buffers=30 

SLD™ Software Installation 

To install the SLD software on your host system: 

1. Run setup.exe from Program Disk 1. 

2. Follow the instructions presented in the window. The files and 
subdirectories are installed in a default directory named \powerpak 
unless you specify otherwise when prompted. (Examples 
throughout this manual use the powerpak directory name.) 
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Toolchains 

3. At the end of the installation, you can view the readme.txt file for 
the latest release notes. 

4. Exit Windows to install the firmware, as noted in the last screen of 
the installation. In Windows 95, and on some systems running 
Windows or Windows for Workgroups, you can install the 
firmware from a DOS window or from the Program Manager. 

5. Insert Program Disk 3 into a disk drive. Either make Program 
Disk 3 the current drive or copy all files from Program Disk 3 to 
the current drive and directory. 

6. Enter install at the DOS prompt; or, in the Program Manager File 
Run dialog box, run install.bat from Program Disk 3. 

7. Follow the instructions presented on the DOS screen. 

The installation creates a powerpak.ini file in your Windows directory. 
Any previously existing powerpak.ini is renamed powerpak.bak. 

To uninstall the SLD software: 

1. Delete the powerpak directory and its contents. 

2. Delete powerpak.ini from your Windows directory. 

3. Delete the emulator icons and group. 

Because of OMF86 and OMF386 loadfile format standards, the output 
formats of most x86 development toolchains differ little. 

When using the Metaware HC toolchain, compile with the switch 
Optimize_for_Space (-Os) OFF and the switch Align_Routines ON. 
This combination aligns the line number information for function entry 
points on the actual function execution addresses. This alignment is 
necessary for the SLD software to set source-line breakpoints on the 
start addresses of the function entries and to display local symbols. 

When using the Borland C compiler, before loading your OMF386 
loadfile, set the emulator's maximum bitfield size to 16 bits. On the 
SLD Shell command line enter: 

maxBitFieldSize 16 

When using PharLap LinkLoc 7.1, use its -regvars switch to include 
symbolic information for register variables. The emulator supports 
register variable extensions to the x86 symbol table. 
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Hardware Configuration 
This chapter explains how to: 

• Connect the emulator to the host system and connect the parts of the emulator together. 

• Connect the emulator to the stand-alone self-test (SAST) board. 

• Power-up and power-down the emulator; run the hardware confidence tests 

• Connect the emulator to a user target. 

Ensuring a Proper Physical Environment 

ESD 
CAUTION 

The emulator or debugger requires the same physical environment as 
your host system: 

• Avoid excessive heat and humidity. Microtek recommends an 
ambient temperature within 0 - 40° C (32 - 104° F) and an ambient 
humidity range within 85% maximum relative humidity, 
noncondensing. 

• Leave a few inches around the main chassis for air circulation. 

• Use good grounding practices against electrostatic discharge. 

• Keep the emulator away from electromagnetic interference. 

The circuitry of the emulator probe can be damaged by excessive 
electrostatic discharge ( ESD ). Protect your probe from ESD: 

• Ensure the emulator, host system, and workbench are properly 
grounded before applying power. 

• Work in a static-free environment. 

• Use a wrist-strap attached to ground while handling the probe. 

• Avoid touching the exposed connector on the probe when you are 
improperly grounded. 

Connecting the Emulator to Your Host System 

The supplied RS-232C cable resembles a telephone cable because both 
use RJl 1 connectors. However, you cannot use a telephone cable in 
place of the supplied RS-232C cable. If you attach the emulator to your 
host system with a telephone cable, the emulator will not work. 

EA/SW Emulator Hardware Reference 11 Hardware Configuration 



RS-232C cable 
plugging into the back 
of the emulator 

Depending on your host system serial port, you may need to substitute 
the 9-pin serial adapter for the 25-pin serial adapter. 

0 
25 Pin Serial Adapter 
(to host system) 

~ 
Connect the emulator to your host system using the RS-232C cable: 

1. Firmly seat the RJl 1 connector in the emulator's RS-232C port. 

2. Firmly seat the 25-pin or 9-pin serial adapter in your host system's 
COMl, COM2, COM3, or COM4 serial port. 

Connecting the Probe Cables to the Emulator 

Emulator and probe 
assembly 

SJ1 and SJ2 plugs 
where the ICE cables 
connect to the front of 
the emulator 

The emulator and probe are shipped as an assembled unit, connected by 
a pair of in-circuit emulation (ICE) cables, as shown in the following. 
If the ICE cables are disconnected, reconnect them. 

Pin 1 

SJ1 
" 

Reset 

I I 
Out Sync 

~ 
SAST SJ2 " External Trace 

OOOOOJ 
I I 

[00000 
0 0 0 0 0 0 0 0 0 0 

The orientation of the cable jacks in the plugs is significant. The jacks 
slide easily into the plugs when oriented correctly. To firmly seat a jack 
on a plug, hook the metal side-clips on the jack into the side-flanges on 
the plug. 

One of the ICE cables is longer than the other. When connecting the 
cables, ensure the longer cable extends from the SJl plug on the 
emulator to the plug closest to the processor on the probe. 

To connect the emulator and probe with the ICE cables: 
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1. Ensure the emulator's power switch is off. 

2. Seat the short cable firmly in the bottom (SJ2) emulator plug. 

3. Seat the bottom (SJ2) cable firmly in the probe plug closest to the 
short side of the probe, with the cable extending away from the 
probe processor. 

4. Seat the long cable firmly in the top (SJl) emulator plug. 

5. Seat the top (SJl) cable firmly in the probe plug closest to the probe 
processor, with the cable extending away from the probe processor. 

Connecting the SAST Board 

SAST board and probe 
assembly 

Power 
CAUTION 

The stand-alone self-test (SAST) board is used for: 

• The confidence tests 

• The tutorial 

• Your target software when your target hardware is unavailable 

The probe and SAST board are shipped from the factory as an 
assembled unit. 

red stripe 

SASTboard 

With the emulator connected to your target board, apply and remove 
power to the emulator and target board in the correct sequence to 
avoid severely damaging both units: 

1. Apply power to the emulator. 

2. Apply power to the target system. 

3. Remove power from the target system. 

4. Remove power from the emulator. 

To connect the emulator to the SAST board: 

1. Ensure the emulator's power switch is off (toggled down). 

2. Plug the probe into the SAST board, matching pin 1 on the probe 
with pin 1 on the SAST board. 
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386EX 
CAUTION 

3. Connect the SAST power cable to the emulator and SAST board. 
The SAST power cable is a gray ribbon cable with one red edge 
and a ten-pin female jack on each end. When oriented correctly, 
the cable is not twisted. Push on the jacks to seat them firmly on 
the plugs. Powering-up the emulator powers-up the SAST board. 

To avoid permanently damaging the emulator and 386EX SAST board, 
be careful to connect pin 1 on the probe to pin 1 on the 386EX SAST 
board. Pin 1 of the probe is labeled as such. Pin 1 of the bondout (the 
386EX processor on the probe) is 180 degrees opposite pin 1 of the 
probe and is marked by a white dot and a notched corner. The 
following shows the pin 1 s. 

Pin 1 of bondout 
Processor 
DO NOT orient Target 
Adapter by this pin 

SAST Board 

Pin 1 of Probe Head 
Use this Pin to orient 

Setting the 386 SAST Board Jumpers 

When adding memory or circuitry to the SAST board, be sure to 
reconfigure any jumpers as needed. The jumpers control power, target 
(not overlay) memory, and reset options: 

5V, 3.3V 

JACK, POD 

RESET 

memory 

Xl,X2 

Hardware Configuration 

selects 5 volt or 3.3 volt operation. 

selects whether power is obtained from the emulator 
via the ribbon cable (POD) or from a separate power 
supply plugged into the SAST board jack (JACK). 

resets the SAST board when shorted. You can use this 
jumper to add a target reset input. 

is controlled by a pair of jumpers. The SAST board is 
shipped from the factory with 8K-byte memory chips 
and both jumpers set to 8K. When adding memory to 
the SAST board, adjust the jumpers accordingly. 

on the CX/SX SAST board must be set on Xl. 
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Setting the 486 Probe Jumpers 

The FPU (floating-point unit) and SLE (SL-enhanced) jumpers on your 
486 probe must correspond to the probe processor for correct emulator 
start-up and the 32B jumper must be installed. The SLE controls 
SRESET, SMI#, SMIACT#, and STPCLK#. The following lists the 
supported 486 processors and the corresponding jumper settings: 

Processor FPU SLE 

DX,DX2 

SX, SX2 

DX, DX2 non-SLE 

SX, SX2 non-SLE 

ON 

OFF 

ON 
OFF 

ON 

ON 

OFF 

OFF 

Applying Power to the Emulator 

Power supply plugging 
into the emulator 

Emulator back panel 
with power switch 
toggled off (down) 

For emulator power, use the provided DC power supply. The emulator 
powers the probe and SAST board via the provided cables. 

,.,,;;,.._..,,,,;:.,... oooo 
DC rnput RS232 ( 0 0 0 0) 8 OCOCf§b 

R-•P~"' 010] """"' o::l:ioc:?oo 
O 0 ~ 0 Jg_ 0 000 

'---~~~~~-~~~~~~~ 

Once the DC power supply is plugged into the emulator and into an AC 
power source, the emulator power is controlled by the power switch on 
the back of the emulator. 

..-~~ .. ~$~ oOc?oo 
DCinput RS232 (0000) []SJ Cbo 

Reset Power o IOI Trigger 0~0c9Jl 
O Jl °! 0 ~ 0 000 

To connect the emulator to the power supply: 

1. Ensure the emulator power switch is off. 

2. Plug the power supply into the emulator DC input jack. 
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Power 
CAUTION 

3. Connect a power cord between the DC power supply and an AC 
power source. 

To power-up the emulator: 

1. Check the seating of the cables between the host system, emulator, 
and probe, and between the AC power source, DC power supply, 
and emulator. Check the seating of the probe in the SAST board 
and the power cable from the emulator to the SAST board. 

2. Turn on the power switch on the back of the emulator chassis. A 
power-on reset occurs and the system processor tests and initializes 
the system. The Power and Selftest LEDs on the emulator glow on 
reset. When the emulator and target have powered-up successfully, 
the Selftest LED dims and the Bus Active LED glows. 

Tum on the emulator before turning on the target system. Power must 
be applied and removed in the correct sequence. Failure to follow this 
sequence will severely damage your target system and the emulator: 

1. Apply power to the emulator. 

2. Apply power to the target system. 

3. Remove power from the target system. 

4. Remove power from the emulator. 

Reading the Status LEDs 

The emulator power-on and processing status is reported by LEDs on 
the back panel of the emulator. 

LED Meaning 

Power Green: The emulator is powered-up. 

Selftest Red: either the system processor is executing the power­
on self tests or a failure has occurred. 

Emulating Green: the probe processor is emulating. 

Bus Active Green: The emulator has established communication 
with the target. 

Press the Reset button on the back of the emulator. When the Selftest 
LED dims and the Bus Active LED glows, start the SLD software. 
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Running the Hardware Confidence Tests 

The confidence tests report whether the emulator hardware is 
functioning properly. For these tests, the emulator must be connected to 
the SAST board. On the EA-486 probe, the FPU, SLE, and 32B 
jumpers must be installed. 

To run the tests, enter a test command in the Shell window Command 
Entry pane. The test command syntax is: 

Test [Loop] [Repeat I Continue] [Brief I Verbose] [Except] 
[<name> I <number>] 

With no arguments, test runs all the confidence tests, displaying the 
final result of each test. 

Argument 

Loop 

Repeat 

Continue 

Brief 

Verbose 

Except 

<name> 

<num> 

Action 

Repeat the low-level operations in the specified test. As 
the operations repeat, you can observe them on an 
oscilloscope. To stop, press <Esc>. 

Repeat the specified tests. To stop, press <Esc>. 

Continue through all tests, even if one fails. 

Display only the test sequence. The default is to show 
the final result of each test in sequence. 

Display progress reports during each test, in addition to 
the default information (the final result of each test). 

Exclude the specified tests and run all others. 

Identify one or more tests by name, as listed below. 

Identify one or more tests by number, as listed below. 

The following lists the test numbers and names and describes what each 
test demonstrates and some actions you can take when some tests fail. 
Not all tests apply to all system configurations. If a test fails despite 
any recommended actions, contact Microtek. 

Number Name 

3 trace Memory 

Tests the emulator trace memory. 

7 xilinxProgram 

Tests the probe firmware programming. If this test fails, try reseating 
the ICE cables between the emulator chassis and probe. 

8 sastConnect 

Tests the control connections between the emulator and SAST board. 
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If this test fails, try reseating the probe and power connections on the 
SASTboard. 

9 targetConnect 

Tests the connections between the probe and SAST board. If this test 
fails, try reseating the probe and power connections on the SAST 
board. 

10 procConnect 

Tests the connections between the probe processor and both the chassis 
and the SAST board. If this test fails, try reseating the probe in the 
SAST board; try reseating the ICE cables between the emulator chassis 
and probe. 

11 iceMemory 

Tests the ICE memory. 

12 procBasic 

Tests the probe processor functionality. 

13 proclnternal 

Runs the built-in self-test of the probe processor. If this test fails, try 
reseating the probe on the SAST board. 

14 mapMemory 

Tests the overlay memory mapping logic. 

15 overlayMemory 

Tests the overlay memory. If this test fails, contact Microtek. 

16 procGrHalt 

Tests the ResetAndGo and Halt operations. If this test fails, try 
reseating the probe on the SAST board. 

17 procGoHalt 

Tests the Go ... Halt operations. If this test fails, try reseating the probe 
on the SAST board. 

18 procReset 

Tests processor RESET behavior. 

19 procStep 

Tests single-stepping. 

20 procSwBkpt 

Tests software breakpoints. 

21 procHwBkpt 
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Confidence test 
examples 

Tests hardware beakpoints. 

22 procTrigger 

Tests the trigger breakpoint logic. 

24 sastMemory 

Tests the SAST memory. 

25 mapBkpt 

Tests breaking on memory access violations. 

26 map Rom 

Tests intercepting overlay memory write violations. 

27 signalGating 

Tests enabling and disabling signals from the target. The configurable 
signals for your processor are listed in the "Target Hardware" section 
of this manual. 

29 catTraceData 

Tests the trace system 

30 targetConnectToggle 

Tests the target connection. 

31 targetConnectAndln 

Tests the target connection. 

>test /* Run all tests and display all results. */ 

>test brief /* Run all tests and display only the final result. */ 

>test verbose /* Run all tests; display all*/ 
/* results and progress reports.*/ 

>test 9 3 4 5 /* Run tests 9, 3, 4, and 5 */ 

>test verbose OverlayRam /*Run OverlayRam test.*/ 

>test loop 13 /*Run scope loop 13 until <Esc> is pressed.*/ 
/*The processor is reset as often as possible. */ 

/*No results are displayed. You can watch the*/ 
/*resets with an oscilloscope as they occur.*/ 

>test repeat 13 /* Run scope loop 13 until <Esc> is*/ 

>test continue 

/*pressed; display results after each iteration. */ 

/* Run all tests, continuing/* 
/*even if one or more tests fail. */ 
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Connecting to a Target System 

Power 
CAUTION 

386EX 
CAUTION 

Tum off both the target and the emulator before connecting the 
emulator probe to a target. Leaving either part powered-on can 
damage the target and emulator. When the probe is attached to a 
target, turn on the emulator before turning on the target. Failure to 
follow this sequence will severely damage both target and emulator: 

1. Apply power to the emulator. 

2. Apply power to the target system. 

After removing the SAST board from the emulator, connect the probe to 
your target using an appropriate adapter. The available adapters are 
described in the "Getting Started" chapter of this manual. 

To connect the probe, adapter, and target: 

1. Ensure the power is off to the emulator and target. 

2. Disconnect the target power cable. 

3. Remove the target processor chip, unless you are using a clip-over 
adapter. 

4. Plug the adapter into your target or clip the adapter over the target 
processor, matching the pin ls. 

5. Plug the probe head into the adapter, matching the pin 1 s. 

6. Apply power first to the emulator, then to the target system. 

To avoid permanently damaging the target and emulator, be careful to 
connect pin 1 on the 386EX probe to pin 1 on the adapter and target. 
Pin 1 is labeled on the probe. Pin 1 of the 386EX processor in the 
probe is 180 degrees opposite pin 1 of the probe and is marked by a 
white dot and a notched comer. The following shows the pin 1 
orientations, using the SAST board as an example target board. 

Processor 
DO NOT orient Target 
Adapter by this pin 

SAST Board 

Pin 1 of Probe Head 
Use this Pin to orient 
Target Adapter 
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Amp adapter for 386 
emulators 

3M!Textool adapter for 
386 emulators 

Clip-over adapter for 
386 emulators 

Solder-down adapter 
for 386 emulators 

EA/SW Emulator Hardware Reference 

User Target/ 

User Target/, 
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Clip-over adapter for 
486 emulators 

Solder-down adapter 
for 486 emulators 

male-male PGA connector 

User Target 

To disconnect the probe from the target processor or socket, ensure the 
power is off to both the emulator and the target; then, gently pull the 
adapter out of the socket or off of the processor. 
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Tutorial 
This tutorial provides a guided tour of some of the most commonly used debugging 
commands, with the opportunity to practice the following: 

• Invoke the SLD software, configure memory, and load a sample program. 

• Navigate the source, memory, stack, and trace displays. 

• Start and stop emulation in various ways. 

• Collect and examine trace information. 

The illustrations in this chapter show this tutorial running on various PowerPack PP, EA, and 
SW emulators. You can use this tutorial with any PowerPack x86 emulator with overlay 
memory. Some displays differ between emulators and between processors. 

This tutorial assumes you have learned to use the Microsoft Windows 
environment. If you are unfamiliar with Windows, study your Windows 
tutorial before starting the SLD software. 

Before starting this tutorial, connect the emulator to the SAST board. 

The \powerpak\samp386\demo.omf sample loadfile, used by this 
tutorial, was compiled and linked using the Microtek Research Inc. 
(MRI) PC toolchain. The source and command files used to generate 
demo.omf are also provided. Examine these files for information 
helpful in recreating the loadfile with your own toolchain. 

Configure the SLD Software for the Tutorial 

Read the "Defining the Debug Environment" chapter in the User's 
Manual, following the instructions for: 

• starting an emulator session, noting which (if any) buttons on your 
Toolbar are grayed-out to indicate unavailable operations 

• selecting the COM port and baud rate for communication between 
your emulator and host system 

• co-ordinating Intel386 emulator and target CPUs (if you are using a 
386 emulator) 

• mapping memory, accepting the default values in the Add dialog 
box 

• loading code and symbols from \powerpak\samp386\demo.omf. 
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Arrange Your Desktop 

~ 
Shell 

Halted Not 
Tracing. 

REAL Mode. 

Status window with 
open Control menu 

Simplify your desktop by minimizing or closing the Shell window. 
The Shell window icon is shown here in the left margin. 

The first time you start the SLD software, the Status window also 
appears. This completes the initial default layout: Toolbar, Shell 
window, and Status window open and all other windows closed. The 
following shows the Status window before you have done any 
emulation or modified any memory or registers. The emulation 
processor is initially in real mode. 

1=•1m1@1m1u.1;1n.;;lit.!ltfflil· 
Break Cause: Hone 

Minimize the Status window to simplify your desktop. The Status 
window icon is shown here in the left margin. Note the status message 
in the label below the icon. 

According to the initial default layout, the Status window (whether 
open or iconized) remains visible regardless of any other SLD window 
position. To change this positioning, open the Status window Control 
menu and disable (toggle-off the checkmark) Always on Top. 

-I• 00 I • !Iiil •OO•:i:lffi-T] 
Be store J 
Move 
.S.ize 
Minimize 
Ma)'.C;imize 

!;.lose Alt+Fll 

Sl!!'itch To ... Ctrl+Esc 

.,/Always On Top 

Examine the Loaded Code and Symbols 

Target 

Tutorial 

In this part of the tutorial, you will practice displaying different parts of 
the loaded code and symbolic information in the Source, Variable, and 
Memory windows. You will be changing only the window display and 
cursor position, without doing any emulation or changing the CS:EIP. 

Display Source 

From the Target section of the Toolbar, choose the Source button. You 
are viewing the startup module in the Source window. The associated 
source filename, startup.asm, appears in the title bar. The current 
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Source window 
showing the startup 
module 

Target 

Memory window 
showing the data 
segment 

Memory dialog box for 
selecting an open or 
new Memory window 

CS:EIP (program counter) is marked by>>. 

; I:, , I< ·J_· 
.Eile .E_dit ~iew .Bun .6_reakpoints Qptions Windows .!::felp 

Go ][ Holt ][ St".]!_lnto ][ St".]!_ Over ][ Into Coll ][Into Return ][Go To Curso!] JD 

[ 000452] PUBLIC _start_ ;Hust be pa1·agraph aligned (i.e. offset is 0) ~ 

( 000453) _start_ proc f.ar ;and the addt·ess where progra111 code stat" ts .r-
» [ 000454) CLI 

[ 000455) 
[ 000456) 

1000457) 
; ************************************************************************ 
; Place code here to do ha1·dwa1·e initialization and RAM check 

Display Memory 

+ •• 

From the Target section of the Toolbar, choose the Mem button to 
display a Memory window. You are viewing the beginning of the data 
segment as hexadecimal word values. 

file .Edit l,'iew .Qptions Yt'indows l:!elp 

DS:0000 4CDF 0F0E 30DF 0F4F 00FF 0F0F 0EFF 0F0F BL .. B00.y ... y ... ~ 

DS:0010 00EF 0F0C 01FF 0F4F 02FF 0F0F 20CF 4F09 1 ... y.O.y ... I .0 
DS:0020 00FF 0F0F 0D6F 8F0C 03FF 0F1F 03DF 0F0F y ... o . . ly .. . B .. . 
DS:0030 08DF 0F0F 00FF 0F0F 06FF 0F0F 08DF 0D1E B ... y ... y ... B .. . 
DS:0040 0FDF 0F0F 05FF 0F0E 09BF 0F07 04FF 0F8F B ........ · ... ".I. ~ 

You can have up to 20 Memory windows open simultaneously. The 
first Memory window is labelled, in its title bar, Memory 0. Choose the 
Toolbar Mem button again to display the Memory dialog box for 
selecting or opening a Memory window. The following shows the 
Memory dialog box, with Memory window 0 available. 

Memory 

1;ielect Memory Window New 
0 : Hex Words OxO 

QK 

~ancel 

!:!elp 

Choose the New button in the Memory dialog box. Another Memory 
window appears, labelled Memory 1. In this Memory window, open the 
Edit menu, choose Go To Address, and enter CS:EIP in the dialog box. 
The memory display changes to the program counter. 
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Go To Address dialog 
box for changing the 
Memory window 
display 

Memory window 
showing the code 
loaded at CS:EIP 

Memory window View 
menu specifying 
disassembly 

Memory window 1 
showing memory 
contents as 
disassembly 

Tutorial 

Go To Address 

Address: 

I CS:EIPj 

Spac.i;.: Onerand/Address Size: 

I user liJ 
._ __ Q_K __ .,,I I ~ancel I I J::!elp I 

~ I I I T A 

.Eile Edit Yiew Qptions ~indows J::!elp 
CS:01AO FCFA 208S SEOO 8FCO 0000 328S 4002 DSSE uU, .IAi .. ,2.@IDr!i 
CS:0180 008E 8SOO 0050 FSS3 7400 S804 F3CS 89A4 ~--,P·~!-t.l~on•~ 
CS:01CO 0060 508F 2800 E3CF 8S05 0000 AAF3 2088 .iP.+Ia .•• o~ 
cs: 0100 8900 0020 CS2B 5AE3 D1SB COSE OOBF 8SOO • ' .+EaZl~IR;,.: 
CS:01EO 0232 SE40 BEDS 0050 C6S8 0481 E8D3 0888 2.@IO~P.l~±.OelD + 

+I •• 
You can use multiple Memory windows to display different sections of 
memory or the same memory in different formats. Initially, both 
Memory window 0 and Memory window 1 display hexadecimal words 
(noted in their title bars). In Memory window 1, open the View menu 
and choose Disassembly. 

~ I 

.j DiS.!!.SSembly 

Hex.!lytes 
Hex~ords 

HexQWords 
Decimal BJlles 
Decimal WQrds 
Decimal DWord§. 

../Auto 
Usel6 
UseJ_2 

../ .!!ser 
SMM 

Refresh Display 

111.f I !13J TJ_A 
Eile Edit Yiew Qptions ~indows J::!elp 

CS: 01AO FA CLI ~ CS: 01A1 FC CLO 
CS:01A2 882000 MOU AX,00201 
CS: 01A5 8ECO MOU ES,AX 
CS: 01A7 BFOOOO MOU DI ,0000 + 
+I + 
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Source window View 
menu specifying mixed 
source and 
disassembly display 

Source window 
showing disassembly 
interleaved with source 

Target 

CPU window (EA-486 
emulator) 

You can see the disassembly in the Source window corresponding to the 
disassembly in the Memory window. In the Source window, open the 
View menu and choose Mixed Source And Asm. The following shows 
the Source window View menu and the consequent display. 

.s_ource Only 
.,/Mixed Source and Asm 

./Line Numbers 

Ol!erand/Address Size 

= Source· ( ... erpak\sampJ86\startup.asm] aa 
.Eile fdit Y:iew Bun 6.reakpoints Qptions Windows l:!elp 

Go Jl Halt II St"1!,.lnto Jl St"1!,.0ver Jl Into Call JL Into Return ][Go To Cursor_I P 
[ 000452] PUBLIC stat·t - ;Hust be ;~~~a~~=p~d~~!~~e~h!~;e ~r:~~!:t c!~e O~tarts -~ [ 000453) _start_ p1·oc far 

~ 000454] Cll I 
» 000454] 0200:01AO FA CLI 

[ 000455] ; 

__L 0004sU ; *********************************************************************** • 
tl. +• 

Examine the line of disassembly at the program counter, indicated by 
>> in the left margin. Compare the address and instruction to the 
Memory window 1 line showing address CS:OlAO. 

Display Registers 
From the Target section of the Toolbar, choose the CPU button to 
display the CPU registers. The program counter consists of the CS and 
EIP registers. CS contains 0200 and EIP contains 01 AO, also shown 
by the line with the >>program counter marker in the Source window 
in mixed view. 

.Qptions 

EFLAGS eeeeeee2 ~ 

avrneoditszapc 
EIP eeeee1Ae 
EAX eeeeeeee 
EBX eeeeeeee 
Ecx eeeeeeee 
EDx eeeeel!1s 
EBP eeeeeeee 
ESP eeee1eee 
EDI eeeeeeee 
ESI eeeeeeee 
cs e2ee 
os eeee ~ 
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Go To Address dialog 
box to display the main 
function in the Source 
window 

Source window 
showing main function 
in mixed source and 
assembly view 

Memory window 
showing disassembly 
from the 
#dm_main#main 
address 

Tutorial 

Find Modules and Functions by Symbolic Address 

The section of code displayed when you first open the Source window is 
at the CS:EIP. Since no emulation has been done yet, the display is in 
the startup module. The title bar at the top of the Source window 
shows the source file for the displayed module. 

Change the Source window display to the main function in the 
dm_main module, using the module and function symbols. In the 
Source window, open the Edit menu; choose Go To Address. Enter the 
fully-qualified symbol #dm_main#main in the Go To Address dialog 
box. 

Go To Address 

~ddress: 

I 1tdm_ m11in#m11inl 

Spaq;_: OJ!erand/Address Size: 

l~us_e_r ---~Iii_± ~jAu_to ____ ~lil_ 

'-'""'Q_K _ _,11 ~ancel I I ttelp I 

file E_dit l,!iew Bun fl.reakpoints Qptions Windows !ielp 

Go Halt Ste Into Ste Over Into Call Into Return 
[ 000057] ** then "printing" again. 
[000058] ---------------------------------------------------------------
(000059] uoid main() { 
[llll0059] 0200:0000 55 PUSH BP 
[000059] 0200:0001 8BEC HOU BP,SP 
[000059] 0200:0003 81EC0200 SUB SP,0002 

The emulator supports physical, linear, virtual, and symbolic addresses, 
interpreting numeric addresses as virtual unless you specify the L 
(linear) or P (physical) suffix. 

In the Memory window, open the Edit menu; choose Go To Address. 
Enter #dm_main#main in the Go To Address dialog box, the same as 
you did for the Source window. 

~ INiiilii.'.ilt•• I .... 
file fdit "{iew Qptions Windows tlelp 
0200 0000 55 PUSH BP ~ 02 00 0001 8BEC MOU BP,SP 

' 
0200 0003 81EC0200 SUB SP,0002 
0200 0007 56 PUSH SI 
0200 0008 57 PUSH DI 
0200 0009 C7065EOOOEOO MOU WORD PTR .L005E_l DODE 
'!.!. ... 
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Browse Modules dialog 
box for displaying the 
dm_main module in the 
Source window 

Source window 
displaying the 
beginning of the 
dm_main module in 
mixed source and 
assembly view. 

Search dialog box for 
finding the first 
occurrance of the 
printall string in the 
Source window 

Source window after a 
successful search for 
printall 

Display the dm_func module in the Source window. Open the File 
menu and choose Browse Modules. Select dm_func in the Browse 
Modules dialog box. Choose OK. 

Browse Modules 

dm_func Load File: C:\POWERPAK\SAMP386\DEMO.OMF 
m main 

startup 

1~1 

Time: 8/12/1994 - 14:21 :30 
Address: 0200:0000 .. 00JF 
Path: 

HI 

Q.K .C.ancel !::!.elp 

•11 
.Eile f.dit ~iew Bun .Hreakpoints Qptions Windows· tlelp 

Go ][ Halt ][ St~lnto l[ St"!!_ Over] Into Call J Into Return]Go To Cursor! _.. 

t 000001] '********************************************************************.,..t. 
[ 000002] ** 
[ 000003] ** Filena11te: dm_nain ~C 
[ 000004] ** 
[ 000005] ********************************************************************** 
[ 000006] 
[ 000007] lldefine HULL 0 • 

tl + 

Find a reference to the printall function. Open the Edit menu and 
choose Search. Enter printall in the Search dialog box. The SLD 
software finds the first occurrance of printall. 

Search 

.S.earch for: 

I printalll 

.QK ~ancel !:!.elp 

I lo I 11 I 

.Eile fdit lliew Bun f!reakpoints Qptions Windows !!elp 

Go ][ Halt ][ St'<.E)nto ][ St~ Over][ Into Call ][Into Return]lf;o To Curso!] _.. 
[ 000042] uoid insert(CELL_TYPE *record, int place); ~ 
[000043) uoid re.,oue(int place); Ill 
[000044) uoid r!ll!llmJ(uoid); + 

tl + 

Find a Function From Any Reference 

You can move the Source window cursor to the entry point of a function 
from any occurrance of the function name. 
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Function pop-up menu 
accessed by double­
clicking on a printall 
string in the Source 
window 

Source window display 
after choosing Go To 
Source in the Function: 
printall pop-up menu 

Go To Line dialog box 
for finding line 162 in 
the Source window 

Source window 
displaying line 162 

Tutorial 

The last search positioned the cursor at the first occurrance of the 
printall function name in the dm_func module. Double-click on the 
function name. The Function pop-up menu appears Choose Go To 
Source. The Source window displays the first line of the function. 

Im Function: printall 
§.o To Source 
~how Load Address 
Set Eerrn. Breakpoint 
Set Iernp. Breakpoint 
!;_lear Breakpoint 

tm•a 
file fdil ~iew Bun Breakpoints _Qptions Windows !:!elp 

Go JL Halt JL Sl"-l!_lnto JL St"-1!_ Over JL Into Call JL Into Return J\!io To Cursorl JD 

t 000153] uoid printall() { 

I [ 000153] 0200: OOFC 55 PUSH BP 
[000153] 0200:00FD 8BEC MOU BP,SP 
(000153] 0200:00FF 81ECOAOO SUB SP ,OOOA 
[000153] 0200:0103 56 PUSH SI .. [ 000153] 0200: 0104 57 PUSH DI 

1_00015'±1_ 
tl .. 

View a Specific Line 

You can find any line in the currently displayed module by line number. 
Open the Edit menu and choose Go To Line. Enter 162 in the Go To 
Line dialog box. 

Go To Line 

Line Number: 

lim 
OK !;.ancel !:!_elp 

tm•a 
file fdit Yiew Bun f!reakpoints _Qptions Windows !:!elp 

Go JL Halt JI_ St"-1!._lnto J_ St"-!!_ Over JI_ Into Call J_lnto ReturnJ~o To Cursorl .-:. 

~ cellPtr • top; /* assign global pointet~ to local pointer */ 
0200:0111 A15EOO MOU AX,(005£] 

(000162] 0200:0114 8946FA MOU [BP-06] ,AX 
[ 000163] out _ptr = outbuf; 
[000163] 0200:0117 C746F85000 MOU WORD PTR [BP-08] ,0050 

tl. .. 

Inspect a Local Variable 

You can examine the definition and value of any variable displayed in 
the Source window. On line 162, double-click on top. In the Variable 
pop-up menu, choose Inspect Variable. 

• ~ 
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Variable pop-up menu 
accessed by double­
clicking on a top string 
in the Source window 

Variable window 
displayed by choosing 
Inspect Variable in the 
Variable: top pop-up 
menu, with the top 
pointer dereferenced 

Result of changing the 
address in top 

Set E'erm. Breakpoint 
Set Tern . Break oint 

In the Variable window, you can change the values of variables (red) 
and dereference pointers (blue). Double-click on top, displayed in blue. 
top points to a structure of two pointers, next and stringPtr, and a short 
integer, length. Variables out of scope have unknown values. 

struct LINKS *top = DS:0F0E; 
LINKS "top ( 

struct LINKS Mnext = DS:1FB7: 
signed char *StringPtr = DS:4AFF: 
signed short int l•ngth = axFB7 = 

Remove the dereferenced structure from the display. Click on the 
LINKS *top {line; open the Variable menu and choose Delete. 

Make top point elsewhere. Double-click on the red OFOE value of top. 
In the edit field box appears, enter 1 FFF. Since top points to a 
different location, the values shown for next, stringPtr, and length 
change. 

truct LINKS *top = DS:1FFF; 
INKS ><top { 

struct LINKS *next = DS:550F; 
signed char *StringPtr = DS:ECSB; 
signed short int length = 0xEC81 = -4991 ; 

Double-click on the lFFF to open the edit field; enter OFOE to reset the 
initially loaded value of top. The displayed values revert. 

View the Program Counter Address 

Reposition the view and cursor back to the current CS:EIP (program 
counter). In the Source window, open the Edit menu and choose Go To 
CS:EIP. The display returns to the startup module. 
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Control Emulation With Breakpoints 

Set Breakpoint dialog 
box, setting a 
permanent, enabled 
breakpoint at the 
beginning of the printall 
function in the 
dm_func module 

Tutorial 

In this part of the tutorial, you will learn different ways to run and halt 
emulation, including the use of breakpoints, the source cursor, and 
immediate emulation controls. 

Set a Breakpoint With the Source Window 
Breakpoints Menu 

In the Source window, open the Breakpoints menu and choose Set 
Breakpoint. In the Set Breakpoint dialog box, select the dm_func 
module and the printall function. Choose Set to set the breakpoint. 

Set Breakpoint 

f!.reakpoint at: l#dm_func#printall 

Modules functions 

ldm_func 

Stl).te---~ 

@Enable 

0 Q.isable 

Set 

T)lpe 
<~ fermanent 

0 Iemporary 

I CIJ!se 

I user 

I !::!elp 

The breakpoint is marked with a red highlight on the first assembly line 
at the specified address. Close the Set Breakpoint dialog box. 

Set a Breakpoint With the Source Window Mouse 
Cursor 

You can use the mouse to set a breakpoint on a specific line or 
instruction in the Source window. When you point the mouse to the 
left of a source line, the SLD software displays a cross-hair cursor 
(shown here in the left margin). 

Use the mouse to set a breakpoint at the beginning of main: 

1. Browse to the dm_main module. In the Source window, open the 
File menu; choose Browse Modules; in the Browse Modules dialog 
box, select dm_main from the list box. 

2. Scroll the display to line 59. Open the Edit menu; choose Go To 
Line; in the Go To Line dialog box, enter 59. The source display 
in mixed view shows the source line 59 followed by the associated 
instructions disassembled from memory. 

3. Position the mouse pointer in the left margin of the Source window 
beside the assembly line [000059] 0200:0007 56 PUSH SI. 
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Source window 
showing breakpoint line 
in mixed source and 
assembly view 

Source window 
showing breakpoint line 
in source-only view 

Source window 
Breakpoints menu 

When the mouse pointer becomes a cross-hair cursor, click a mouse 
button to set the breakpoint. The primary button sets a permanent 
breakpoint. The secondary button sets a temporary breakpoint. 
The breakpoint line is highlighted in red. 

' I :, I 

file fdit ~iew Bun Breakpoints Qptions Windows tlelp 

[ 000058 ] - - - - - - - -------- - ------------ - - ------------ - - - -- - - ------- - - - -- - -- - - ------*/ 
( 000059] uoid main() { 
(000059] 0200:0000 SS 
k 000059] 0200: 0001 8BEC 
[000059j 0200: oooa 81 Eco200 

(OOOOS9] 0200:0008 57 

ft .. , ''-'-'· .,+ 0· ...... . w 

PUSH 
MOU 
SUB 

BP 
BP ,SP 
SP 0002 

PUSH DI 

xv:-~rnE%-='::»~:=w::1mru m~, , .:: 

Mixed view highlights the assembly line with the breakpoint. Source­
only view highlights the entire source line, regardless of which 
instruction or statement has the breakpoint. Open the View menu and 
choose Source Only to display source without interleaved disassembly. 

·,' 
.Eile fdit Yiew Hun !;!reakpoints _Qptions ~indows Help 

[ 000056] ** "printing" to an output buffet·. 1·e1T1ouing the linked cell, 
[000057) ** then "printing" again. 

000058 ------------------------------------------------------------------------*/ 

[ 000061] 
[ 000062] /* initialize top pointer */ 

View the Currently Set Breakpoints 
Open the Source window Breakpoints menu and choose Show All. The 
Breakpoint window appears, listing all currently set breakpoints. 

m::lllilllf! "lllil!lll 

Set Eermanent Breakpoint 
Set Iemporary Breakpoint 
Set f!_reakpoint ... 

!;I ear 
f_nable 
Qi sable 

Clear All 
Enable All 
Disable All 

)ihowAll. .. 

EA/SW Emulator Hardware Reference 33 Tutorial 



Breakpoints window 
opened by the Source 
window Breakpoints 
menu Show All item 

Source window display 
(in mixed source and 
assembly view) 
corresponding to a line 
in the Breakpoint 
window 

E111ulation 

Registers in CPU 
window modified by 
program execution 

Tutorial 

file Breakpoints Windows !::!elp 

Set ][ Clear ][o To Soun;!![ Enable ][ Disable ][Enable All][Disable All 

State ~ Brea~oints 
s 1 s n~ .. u .11J • il:lliil 

lEnable Perm. 00002000L dm_main,main,line59,col1-1 
J 

With the highlight on the printall breakpoint, choose the Go To Source 
button. The Source window displays the breakpoint line, as follows. 

file fdit 1{iew Bun J;!reakpoints 

Emulate To a Breakpoint 
On the Toolbar, choose the Go button. Emulation starts, then breaks 
on the first breakpoint. The new CS:EIP address is marked by>> (the 
program counter) as well as by the red highlight (a breakpoint). 

Look at the CPU window. During emulation, some CPU register values 
changed and are highlighted. 

Qptions 

EFLAGS 

EIP MtlMiitl 
EAX ....... ...._.~ 
EBX 00000000 
ECX 00000000 
EDX 000001115 

0000 ' 0000 ' 
EBP 
ESP 
EDI 
ESI "' "' 

''' "' cs 0200 
osm 
EStiI!m 
FS 0000 
GS 0000 
ssm 

. 
: 

' 
' 
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.Qptions 

DSBASE '"" oc 
DSLIMIT 0000FFFF 

DSAR FF3F93FF 
ESBASE lolclolclct1olcil 

ESLIMIT 0000FFFF 
ESAR FF3F93FF 

FSBASE 00000000 
FSLIMIT 0000FFFF 

FSAR FF3F93FF 
GSBASE 00000000 

GSLIMIT 0000FFFF 
GSAR FF3F93FF 

SSBASE lololololot.11olo1 

EA/SW Emulator Hardware Reference 



Control Emulation With Buttons and Menus 

Source window display 
after stepping into the 
insert function 

Source window cursor 
on RET instruction 

Emulate By Stepping 

In the Source window, open the Run menu and choose Step Into to step 
into an executable statement. The CS:EIP moves to the next executable 
statement. In mixed view, stepping is one assembly line at a time; in 
source-only view, stepping is one source line at a time. Ensure the 
display is in mixed view before continuing this tutorial. 

Continue choosing Step Into until the CS:EIP is on the disassembly line 
[000067] 0200:0017 E82600 CALL dm_func#83 (insert). The next 
Step Into will emulate into the insert function call, changing the source 
display to show the CS:EIP indicator on the first executable line of the 
insert function. Choose Step Into again. 

= ' ' .. . ' ''' 
~ 4 

Eile E_dit l[iew Bun !lreakpoints Q_ptions Windows l:!elp 

Go JI Halt J_ St~]J_lnto JI_ Stell_ Over JI_ Into Call JI Into ReturnJ"" To Curs<!_f .. 

i:::::;i ~~i~-i~~;;~(~~~~~;~~~-:;;~~;~~-i~~-~~~~~)-{--~=-i~~~;~-~~~~-~~-~~~i 
>>[000083] 0200:0040 55 PUSH OP 

, .... .,, "'"""' '"" m• ..... I [000083] 0200:0043 81EC0800 SUB SP,0008 
[000083] 0200:0047 56 PUSH SJ 
[000083] 0200:0048 57 PUSH DI 
b-~ + 

tl .. 

Emulate to the Cursor 

You can progress emulation to a specific line without setting a 
breakpoint. Open the Source window Edit menu; choose Go To Line 
and enter 103. With the mouse, click somewhere on the line [000103] 
0200:00A3 C3 RET (not in the left margin) to position the source 
cursor on the return instruction. 

I~ . " ~ 

file fdit Yiew Bun Breakpoints _Qptions .Windows tlelp 

4 

Go I Halt ] St~lnto ] St~Over J Into Call I Into Return I Go To Cursor l__ 
[090103] ) /w. end of insert *-/ H [0001031 e200,e09E SF POP DI H 
[000103] 0200,009F SE POP SI H 
[000103] 020e,00A0 SBES MOU SP,BP 
[000103] 0200,00A2 SD POP BP 
[000103] 9200o00A3 C3 li!il ~ 

.. 1..1. I+ 

Open the Run menu and choose Goto Cursor. The CS:EIP moves to the 
location you selected with the cursor, as shown in the following. 
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Source window 
displaying current 
execution point 
(CS:EIP), indicated by 
>> 

= ' ~- .. Eillill!.il lll! ~I· 
Eile !;di! ~iew Bun f!reakpoints Qptions ~indows !:!elp 

Go ][ Hall ][ St~lnto ][St~ Over][ Into Call ][Into Return][o To Curs<!) ""' 
[000103] } /* end of insert */ 

• [ 000103] 0200: 009E 5F POP DI 
[000103] 0200: 009F 5E POP SI 
[000103] 0200:00AO 8BE5 HOU SP,BP 

' 
[ 000103] 0200: OOA2 5D POP BP 

»[llililiI!EJ 0200:00A3 C3 RET 
_Looo104i 

•:l .. 
Go To commands in the Edit menu move the cursor without without 
changing the CS:EIP. Go To commands in the Run menu change both 
the CS:EIP and the source cursor. 

View the Call Stack 

Target 

Stack window showing 
the stack and return 
addresses, 
parameters, and local 
variables of the 
function where 
emulation is halted 

Tutorial 

Once you load and execute a program through several function calls, 
the stack list contains stack frames. In this part of the tutorial, you will 
learn how to configure and read the Stack window. 

Open the Stack Window 

On the Toolbar, choose Stack. 

file Qptions Windows Help 

Stack Return 
SS:105A CS:02F1 insert( ... ) 

Parameters a Local Uariables 
signed short int insertlplace = 0x44DF 
struct LINKS *insertlrecord = DS:0200; 
struct LINKS *insertlptr = DS:SS50; 
struct LINKS *insertlcur = DS:0050; 
signed short int insertli = 0x3 = 3; 

17631; 

The Stack window contains two panes and a stack meter: 
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Stack window Options 
menu 

Source window 
showing source and 
disassembly for the 
insert function on the 
stack 

Stack list (top pane) displays the nested call sequence leading up 
to the current context. Each call is shown as a single 
line, called a frame. Click on a frame in the stack list 
to highlight (select) it. Stack and code addresses 
appear, depending on the Options menu settings, in 
each frame: 

Stack address is the address of the frame in the stack. 
Dashes mean the compiler generated no 
stack frame for the function. 

Code address is the address in the calling function to 
which the program counter will return. 

Variables list (bottom pane) displays the local variables and 
parameters of the selected frame in the stack list. An 
unknown value for a variable means the variable is not 
in scope and is not saved on the stack. The colors in 
the Stack window variables list have the same 
meanings as in the Variable window. 

Stack meter (to the right of the top pane) shows what percentage of 
the stack area is currently used. Blue shows current 
stack usage; yellow shows stack underflow; purple 
shows stack overflow. You can configure the stack 
meter for statistical information about stack area usage. 

You can view any listed function's source. With the highlight on the 
insert frame in the stack list, open the Options menu and choose 
Inspect Source. 

= 

~tack Area ... 
Alarm Limit... 

J Include Stack Address 
J Include Return .Qode Address 

Enable High-Water Mark 
Enable _Alarm Limit 

1nspect Source 

Source (. owerpak\samp386\dm_func.c) aa 
file fdit '.'Liew Bun Breakpoints .Qptions Windows Help 

Go ][ Halt ][ St~lnto ][ St"1!_0ver ][ Into Call ][Into Return ][Go To Cursoi.] mi 

[ 000082] ------------------------------ - -------------------- - ---------- - ------ - --• / ~ 
[000083] void Uillll]CCELL_TVPE *t"ecord, int place) { /*insert cell at 'place· */ 
(000083] 0200:0040 55 PUSH BP 

(000083] 0200:0041 88EC HOU BP,SP ' 
[ 000083] 0200: 0043 81EC0800 SUB SP, 0008 
[000083] 0200:0047 56 PUSH SI 
(000083) 0200:0048 57 PUSH DI + 

tl •• 
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Shell window Stacklnfo 
command 

Source of startup code 
initializing SS:ESP 

CPU window showing 
the current values of 
SS and ESP, with ESP 
highlighted to indicate 
change during 
emulation 

Tutorial 

Track Stack Usage Statistically 
In this section, you will configure the stack meter to show stack usage 
statistics. For the stack meter to be active, the stack base and stack size 
known to the emulator must logically match the current SS and 
accomodate the current ESP used by the program. 

The initial stack base was reported in the Load Complete information 
box immediately after you loaded demo.amt. This value is unchanged 
because you have entered no Shell or menu command to change it. To 
retrieve the stack base, enter stackinfo in the Shell window. 

= ~JA 

.Eile [dit 1;'.iew Qptions ytindows Jjelp 
stackinfo 

i II stack base = 0026 :1000 
11 size = 4096 
II current stack pointer = SS:104E 
II alarm limit = 95%, DISABLED 

~ II high water mark = DISABLED 
II stack type = high to low 
~I + 

> ~ ~ .. 
[+I + 

The initial stack base was put into the loadfile during linking. The 
startup code changes SS:ESP. 

Iii Source: [ ... erpak\samp386\startup.asm) aa 
file Edit ~iew Bun l}reakpoints Qptions Windows ]:!elp 

Go ][ Holt ][ St~lnto ][ St~Over ][ Into Call ][ Into Return ][Go To Curso!] Q 

[ 000666] HOU SS,AX ; Setup sta&k pointer ~ [000666] 0200:02C1 8EDO HOU SS,AX 
[ 000667] HOU SP ,OFFSET DGROUP :stack~ top 
[000667] 0200:02C3 BC6010 HOU 

_i_o00661li ASSUH[ SS: DGROUP 
SP,1060 

~ 

.Qptions 

ESP ~-...ii;; 
EDI 00000050 
ESI 00000050 
cs 0200 
OS 0020 
ES 0020 
FS 0000 
GS 0000 
SS 0020 

' +• 

The stack meter in the Stack window monitors stack activity within an 
area defined by a stack base and size that you can set with Shell 
commands and Stack window menu items. When the SS:ESP is inside 
this monitored stack area, the stack meter is active and the statistical 
options (stack alarm and high-water mark) can be enabled. 
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Shell window 
SetStackArea and 
Stacklnfo commands 

Stack 
CAUTION 

Stack window with 
active Stack meter, 
showing 7% (about 18 
bytes) of the stack area 
(256 bytes at 
0020:1060) in use 

The SS :ESP is 0020: 104E, outside of the stack area defined by the 
Stack window stack base (0026: 1000) and size ( 4096). However, this 
SS:ESP is consistent with the SS:ESP set in startup (no subsequent 
code has relocated the stack). 

Change the Stack window stack base to 0020: 1060 to match the startup 
SS:ESP. To make small stack usages visible on the stack meter, reduce 
the Stack window stack size to 256. Use setstackarea for both 
changes, then stackinfo to display the new monitored area. 

file _Edit _lliew .Qptions '.\l[indows !::!elp 

setstackarea 0020:1060 256 ~ 

stackinfo 
II stack base= 0020:1060 
II size = 256 
II current stack pointer= SS:10qE 
II alarm limit : 95%. DISABLED 
II high water mark = DISABLED 
II stack t e = hi h to low 

Avoid changing the SS and ESP shown in the CPU window. Changing 
these registers would affect the stack used by your program. 

The stack meter in the Stack window becomes active. 

file .Qptions Windows !::!elp 

Stack Return 
SS:105A CS:02F1 insert( ... ) 

Parameters & Local Uariables 
signed short int insertllphc~ = 0x'!l.IDF 1 7631 ; it 
struct LINKS *insertllrecord = DS:0200; 
struct LINKS *insertllptr = DS:0050; 
struct LINKS *insertllcur = DS:0650; 
signed short int insertlli = 0x3 = 3; :• . -~ 

EA/SW Emulator Hardware Reference 39 Tutorial 



Warning message that 
a pattern will be written 
to the unused part of 
the monitored stack 
area 

Stack window Options 
menu with high-water 
mark and alarm limit 
enabled 

Tutorial 

Changing the stack size recognized by the emulator does not affect the 
amount of memory available to the program for stack activity. 
Changing the stack base recognized by the emulator does not affect the 
SS or ESP. The stack base and size are used only by the emulator to 
maintain the stack usage statistics. 

Display the greatest stack usage since stack initialization. Open the 
Options menu and choose Enable High Water Mark. The high-water 
mark appears as an arrow on the stack meter (see figure at left). 
Initially, the high-water mark is set at the current level of stack usage, 
and any unused part of the monitored stack area is filled with a pattern. 

Stack area will be filled with a 
pattern to enable 
HighWaterMark. 

I .QK I ~ancell I .!::!elp I 

Set a stack alarm to warn when stack usage exceeds a specified 
percentage of the stack area. Open the Options menu and choose 
Enable Alarm Limit. The alarm limit appears as a red line at 95% on 
the stack meter. Each time emulation stops, if the alarm limit is 
currently exceeded a warning message appears. The following shows 
the Options menu with the high-water mark and alarm enabled. 

II• •lJillillll 
§tack Area ... 
Alarm Limit. .. 

.,/Include S!ack Address 

.,/Include Return .!;_ode Address 

.,/Enable !::!igh-Water Mark 

.,/Enable Alarm Limit 

!nspect Source 
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Stack meter with high­
water mark and alarm 
limit enabled 

II Stack 11111 
file Qptions Windows Help 

Stack Return 7.0% 
SS:105A CS:02Ft insert( ... ) 

Parameters & Local Uariables 
signed short int insertttplac~ = 0x44DF 17G31: 
struct LINKS *insertttrecord = DS:0200; 
struct LINKS *insertttptr = DS:0050; 
struct LINKS *insertttcur = DS:0050; 
signed short int inserttti = 0x3 = 3; 

The Stack window is updated only when emulation stops. To monitor 
the stack during execution, emulate with Step Into/Over Continuously 
from the Source window Run menu. Each step updates the Stack 
window. Choose Halt to stop stepping. 

Collect and Examine Trace Information 

Source window 
showing breakpoint on 
printall RET instruction 

E111ulation 

In this part of the tutorial, you will collect and view trace information. 

Ensure no breakpoints are set. In the Source window, open the 
Breakpoints menu and choose Clear All. In mixed view, set a 
breakpoint on the RET instruction at the end of printall. 

[000177] } /* end of printall */ 
[000177] 0200:0193 SF POP DI 
[000177] 0200:0194 SE POP SI 
[000177] 0200:0195 8BES MOU SP,BP 

000177 0200: 0197 SD POP BP 

[ 000178] !Ii . 

• U.J ....................... . 

On the Toolbar, choose the Go button. Tracing starts when emulation 
starts and stops when emulation stops. The Status window title lists the 
emulation and tracing status. 
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Status icon and 
window during 
emulation and tracing 

Source window 
showing emulation 
halted at the breakpoint 

Trace 

EA-486 trace display 

Trace window View 
menu specifying trace 
be displayed as 
disassembly 

Tutorial 

Running. 
Tracing: 0. 
REAL Mode 

1=-M;ii!.!,!i.Uidfflll.Ulrli=Ml$tifll-

Emulation and tracing stop at the breakpoint. 

• I 11 I 

Eile J;:dit l!iew Bun !;!reakpoints Q_ptions '6'indows !:!elp 

[ 000176] 
[ 000176] 
[000176] 
[000177] 
[000177] 
[000177] 
[000177] 

000177 

slii ilotiC s1l!·;over sumn::l'lrr"' :fnfo'R#iilih ~T.f;l:lijfo<rl 
0200: 018A 837EFAOO CHP 
0200: 018E 7403 JZ 
0200: 0190 E9BCFF JHP 
} /* end of printall */ 
0200: 0193 5F POP 
0200: 0194 5E POP 
0200: 0195 8BE5 HOU 
0200: 0197 5D 

WORD PTR [ BP-06] , 00 
SHORT dm_funcll177 (printall) 
dm_funcll166 (printall) 

On the Toolbar, choose the Show button to display the Trace window. 
The trace information appears as bus cycles. Scroll back to address 
000218A, corresponding to address 0200:018A in the Source window. 
You can see the opcodes on the data bus corresponding to the opcodes 
in the Source window disassembly. (In a Memory window showing the 
hexadecimal values, you can see the same opcodes there.) Besides the 
opcodes at code addresses, other values appear on the data bus 
associated with addresses not among the loaded code. These are 
memory reads and writes resulting from the opcode executions. 

file .Edit ':i[iew Irace Timestamp _Goto .Windows tlelp 

9 bbbb mdw rb bbsk hh rsni pp ae f p b f xxxxxxxx 
times tamp a address data eeee icr dr sl me 11 srmn cw ha e c o l ....... . 

-~ -120 ns 00001250 00201 OSA ~~!~ ~DR ~~ ~7~~ ~~ ~~!~ ~~ ~~ ~ ~ ; ~ ~~~~:~~~ 7 
-3 -120 ns oooe12so 00201esA 1100 HDR 01 1110 oo 0000 10 01 1 1 1 1 ooooeoooH 

:! :!~ ~= ~~~m~~ mm~~ m~ ~~: ~i :m ~~ ~m :~ ~: : : : i m~~~~~~ 
J.:'~1~1~~~~~~~~~~~~~~~~~~~~~~~~~~---1--1~' 

In the Trace window, open the View menu and choose Instruction. The 
trace information is disassembled. 

42 

f;lock 
.6us 

I instruction 

I Linked Cursor 

I Iimestamp 

I 8uto 
Usel6 
Use.;I2 
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Disassembled trace in 
Trace window 

Source window display 
corresponding to Trace 
window display (linear 
address 02193, 
appearing at frame -45 
in the above Trace 
window) 

T ~ 

file Idit Yiew I race Tjmestamp §oto Y,.:indows Help 

-56 -1. 6800 us 0G00218AL CMP WORD PTR [BP-06] ,00 1' 
-55 0000124AP mem read: 0000 H 

-51 -1 .5600 us 0000218EL JZ SHORT dm_funcl177 (printall) 
-45 -1 .3600 us 00002193L POP DI 
-33 00001242P mem read: 0050 
-31 -960 ns 00002194L POP SI 
-28 00001244P mem read: 0050 
-26 -800 ns 0G002195L MOU SP.BP H 
-23 -720 ns 00002197L POP BP Ff -22 00001250P mem read: 105A 

l+ll .. 
With the Trace window in instruction view, open the View menu again 
and choose Linked Cursor. Yellow highlights appear on corresponding 
lines in the Source and Trace windows. Scroll the Trace window and 
observe how the Source window scrolls synchronously. 

This is the end of the tutorial for the SW emulator. 

Control Emulation and Tracing With Triggers 

Setup 

The remainder of this tutorial requires an EA emulator. 

In this part of the tutorial, you will: 

• Define events and triggers for collecting trace information. 

• View the collected trace information and find the triggering event. 

View And Configure The Trigger Window 

On the Toolbar, choose the Trigger button. The Trigger window has 
two panes: 

Condition 

Actions 

(on the left) causes the trigger. Conditions can be events, 
counter or timer values, and external active-low signals. 

(on the right) respond to each condition. Actions can 
control trace collection, emulation, and trigger conditions. 
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Trigger window 

Trigger window 
Options menu with 2 
Timers enabled 

Tutorial 

If the labels on the conditions and actions are displayed incorrectly, a 
screen font manager such as Adobe Type Manager may be overriding 
the SLD software default font. In Windows, tum off the font manager 

Trigger - Level O 

file Edit Qptions Level .Windows Help 

Condition Actions 
event name emble ext Sl;!_Q_ rst btk ton toff trac tricr strtO stQJ;l_O rstO strtl stQll_l rstl ext out 

! D 
! D 
! D 
! D 
! D 
! D 
! D 
! D 

jtrmoBD 
1tmr1 1 D 
ext D 

If the Trigger window on your screen shows a pair of counters or 
timers, open the Options menu and choose Cascaded Timer. 

Irace Capture ... 

2 .Counters 
./ .2_Timers 

C_gscaded Timer 

./~us 

Clock 

Trigger In Active 1:!igh 
./ Trigger In Active LQw 

Trigger Out Active High 
Trigger Out Active Low 

./Trigger Out.Qpen Collector 

Define an Event to Trigger Trace Collection 

rstts 

In the Trigger window, click on an event area (or open the Edit menu 
and choose Events). The Event window appears. Since no events are 
yet defined, the Add Event dialog box also appears. Enter the name 
Event1. 
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Add Event dialog box, 
defining the new 
Event1 event. 

Event window defining 
Event1 as a memory 
code read (instruction 
fetch) at the beginning 
of the printall function 

Add Event 

Name: 

I Eventll 

Editing the Event window differs from filling-in a dialog box. Pressing 
<Enter> has no effect on the field you are editing. Pressing <Delete> 
can cause an error. To ensure a field accepts an entry: 

1. Position the cursor in the field. 

2. Type the value. 

3. Move the cursor to a different field. 

Edit the Event window as shown in the following figure (the signals in 
the Event window may be different for your processor), defining Eventl 
as the execution of an instruction from any of the first 10 memory 
locations where printall is loaded. After filling-in all necessary fields, 
move the cursor to a different field and close the Event window. 

Event: Eventl II 
file _Edit Windows Help 

Active Event: ._IE_ve_n_tl _______ ~I !~I 
not start r-"l~~E=n=d~A=d=dr_~O~L=e~n~qt=h~ ~m_a_s_k -~ 

addr: D ._I #_pr_in_ta_u _____ __,I ._I #'--pr_in_ta_ll ______ __,11 OxFFFFFFFF I 

start end mask 

data: D [~--~][~--~][~~] 

OlX OlX OlX OlX OlX 

0 0 I~ BE3# 0 0@ RDY# 0 0@ HLDA 0 0 @) AHOLD 0 0 I~) ext.1 
0 0 I~ BE2# 0 0 @ BRDY# 0 0 @ RESET 0 0 @) EADS# 0 0 @) ext.2 
0 0 @) BEl# 0 0 @) BSB# 0 0 @ SRESET 0 0 @ FERR# 0 0 @! ext.3 
0 0 @ BEO# 0 0 @ BS16# 0 0 @ NMI 0 0 @ PCHK# 0 0 @ ext.4 
0 @ 0 MllO# 0 0 @ SMIACT# 0 0 @' INTR 0 0 @) BOFF# 0 0 @ ext.5 
I~ 0 0 DIC# 0 0 1~1 KEN# 0 0@ PCD 0 0@ FLUSH# 0 0 @ ext.6 
@ 0 0 W/R# 0 0 I~ HOLD 0 0 @) PWT 0 0 <c!> ext.O 0 0 @ ext.7 

Specify Trace Capture Options 
Open the Trigger window Options menu Trace Capture dialog box and 
select the options as follows: 

• Trigger Position Center, to stop trace 125000 cycles after a trig 
action 

• Capture Mode Clock Cycles, to capture trace as clock cycles that 
can be disassembled 
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Trace Capture dialog 
box specifying that: 

• Trace capture starts 
when emulation 
starts and stops 
125000 clock cycles 
after a trig action. 

• Clock cycles and 
branch messages 
are captured. 

Tutorial 

• Instruction Mode Assist, to capture the branch messages needed for 
disassembly 

• Collect Trace When Emulation Starts, to start tracing when you 
start emulating 

Trigger Position 

()Ere 

®1¢.~~i~r: 
OPoJ!,t 

Capture Mode 

@:1 Clock Cycles 

0 ftus Cycles 

IZJ lnstruction Mode Assist 

IZJ Collect Irace When Emulation Starts 

QK I I .C.ancel I I tlelp 

Define the Action to Take When an Event Occurs 

In the Trigger window, select the top Event box to specify Eventl. 
Select the enable box to enable the trigger. Select the trig check box, so 
when Eventl occurs the emulator will: 

1. Trigger. 

2. Fill the trace buffer, positioning Eventl according to the Trace 
Capture specifications. 

3. Tum off tracing without halting emulation. 

To halt emulation at the same time as halting trace: 

1. For Eventl, select the start check box, to start the timer. 

2. The trigger position in the Trace Capture dialog box is Center, so 
trace is captured for 125000 clock cycles after Eventl. Set the 
timer to halt emulation after 125000 clock cycles. 
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Trigger window (EA), 
showing the following 
enabled for the Level O 
trigger: 

• the Event1 event 
condition to perform 
a trig action and start 
the timer 

• the Cascaded Timer 
condition to break 
emulation after 
125000 clock cycles 

Efllulation 

Status window 
progression during 
emulation with trace, 
during emulation 
without trace, and after 
emulation halts 

Trace 

Eile .Edit Qptions .Level ytindows Help 
Condition 

event name enable ext 

Even11 ! IZl D 
!D 

r--------1'-"!"'D 
!D •>-----1-!---iD 

!D •>-----1-!---iD 
!D 

1 ~n-.=l 1=2s1=Joo='==il IZl D D D IZl D D D D D D D D D 

Collect, View, and Save the Trace Information 

Ensure no breakpoints are set. In the Source window, open the 
Breakpoints menu and choose Clear All. 

From the Emulation section of the Toolbar, choose the Go button. 
Tracing starts automatically with emulation. When the Eventl trigger 
occurs, tracing stops and emulation continues. When the Cascaded 
Timer trigger occurs, emulation halts 

Running. 
Tracing: 0. 
REAL Mode. 

Running. Not 
Tracing. 

REAL Mode. 

Halted. Not 
Tracing. 

REAL Mode. 

j=M;iii.!.!i.UllF!iji.Ui1Mij#-ilttif!I-

jj•;111 1 1n1 1 1.1~&11m11il.M;iif.1Mtffl!IMj 

Break Cause: User Halted 
~1 

From the Trace section of the Toolbar, choose the Show button. The 
following figure shows trace buffer 0 displayed in a PowerPack Trace 
window. Read the signal mnemonic labels vertically. The trace frame 
number appears in the leftmost column. 

EA/SW Emulator Hardware Reference 47 Tutorial 



Trace window, 
displaying trace as 
clock cycles, with the 
trigger frame in view 

Search dialog box to 
find the trigger frame 

II Trace all 
file fdit Yiew Irace Timestamp Y.oto Windows Help 

bbbb mdw rb bbsk hh rsni pp ae f p b f xxxxxxxx 
data eeee icr dr s1 me 11 srmn c"' ha e e o l 

g 
timestamp a address 

p 
-1 -'10 ns 000020FC 

000020FC 
000020FC 
000020F8 

5A5E8B~1 ~~!~ ~CR ~i ~~~~ ~~ ~~~! ~! ~~ ~ ~ ~ ~ ~!~~~~~~ 7 
81 EC8855 0000 MCR 01 1110 00 0000 10 01 1 1 1 1 00000000 H 
81 ECSB55 0000 MCR 01 1110 00 0000 10 01 1 1 1 1 00000000 H 
C35DE58B 0000 MCR 01 1110 00 0000 10 01 1 1 1 1 00000000 ~ 

0 
1 
2 "10 ns 

i~11 

Using the View menu, display the trace as bus cycles and instructions. 
Observe the frame numbers. Because bus cycles and instructions can 
span multiple clock cycles, frame numbers in those views are 
discontinuous. 

Scroll the section of trace around the trigger frame (frame 0) off screen 
and find it again with the Edit menu Search dialog box. The trigger 
frame is the clock cycle matching the condition that caused the trig 
action: Eventl. In the 125000 clock cycles of trace collected after the 
trigger, the condition may have occured again, so the first occurrance of 
Eventl is the trigger frame. In the Search dialog box, specify Eventl 
and a negative frame number. 

... 

by its event definition JEvent1 

:::::======: 

Trace window showing 
trace as disassembly 
near the trigger frame 

Tutorial 

Start Erame: ~J-_ao_o ___ ~ 

QK J J !;_ancel J J !:!_elp 

View the trace information as disassembly 

file fdit Yiew Irace Timestamp yo to Windows !:!elp 
-2q 000012qEP mem read: 001A 
-12 -360 ns 0000201AL ADD SP,01! 
-8 -280 ns 0000201DL CALL dm_funcll153 (printall) 
8 00001252P mem write: 0020 
lj 120 ns 000020FCL PUSH BP 
8 00001252P mem write: 0020 

11 320 ns 000020FDL MOU BP,SP 

Ensure the Source window is open in mixed view. In the Trace 
window, open the View menu and enable Linked Cursor. The Source 
window displays the disassembly and source lines corresponding to the 
Trace window display. Scrolling the Trace window scrolls the Source 
window synchronously. 
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Source window 
showing the in mixed 
source and assembly 
corresponding to the 
Trace window display 
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writing to ·outbuf") 

dm_funcll153 

Tutorial 
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Target Hardware 
This chapter provides schematics and signal information specific to the EA-486 and SW-386 
emulators and SAST boards. 

Trace and Event Window Signals 

The Trace (SW and EA emulators) and Event window (EA emulators) 
display signal mnemonics corresponding to the processor mnemonics. 
Different signals arc supported for different emulators. 

Address and data bus traces are supported for all emulators. Address 
trace is 24, 26, or 32 bits wide. Data trace is 16 or 32 bits. 

486 Emulators 

The following describes the supported signals for the EA-486 Trace and 
Event windows. Active-low signals are indicated by an octothorp (#). 
Check marks ( v') indicate which signals are supported for which 
processors. The 486 DX and SX entries also apply to DX2 and SX2, 
respectively. 

486 Processor Type Mnemonic Labels in Window 

SLE non-SLE 

DX sx DX sx Trace Event 
,( ,( ,( ,( AHL AHOLD 
,( ,( ,( ,( BEO BEO# 
,( ,( ,( BEl BEl# 
,( ,( ,( ,( BE2 BE2# 
,( ,( ,( ,( BE3 BE3# 
,( ,( ,( ,( BOF BOFF# 
,( ,( ,( ,( BRY BRDY# 
,( ,( ,( ,( B16 BS16# 
,( ,( ,( ,( BS8 BS8# 
,( ,( ./ ,( DC DIC# 
,( ./ ,( ,( EAD EADS# 

./ ,( FER FERR# 
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Target Hardware 

486 Emulator Trace and Event Window Signals (continued) 

486 Processor Type Mnemonic Labels in Window 

SLE non-SLE 

DX sx DX sx Trace Event 
./ ./ ./ ./ FLU FLUSH# 

./ ./ ./ ./ HLA HLDA 

./ ./ ./ ./ HLD HOLD 

./ ./ ./ ./ INT INTR 

./ ./ ./ ./ KEN KEN# 

./ ./ ./ ./ MIO M/10# 

./ ./ ./ ./ NMI NMI 

./ ./ ./ ./ PCD PCD 

./ ./ ./ ./ PCK PCHK# 

./ ./ ./ ./ PWT PWT 

./ ./ ./ ./ RDY RDY# 

./ ./ SMI SMI# 

./ ./ SMA SMIACT# 

./ ./ SRS SRESET 

./ ./ ./ WR W/R# 

386 Emulators 
The following describes the supported signals for the SW-386 and EA-
386 Trace and Event windows. Active-low signals are indicated by 
octothorps (#). Check marks(./) indicate which signals are supported 
for which processors. Singly marked signals are supported by the EA 
only. Doubly marked (././)signals are supported by both the SW and 
the EA. 

386 Processor Type Mnemonic Labels in Window 

CX SX EX Trace Event 
./ A20 A20M# 

./ ./ ./ ADS ADS# 

./ ./ ./ ./ ./ ./ BHE BHE# 

./ ./ BS8 BS8# 

./ BSY BUSY# 

./ CS6 CS6# 
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386 Emulator Trace and Event Window Signals (continued) 

386 Processor Type Mnemonic Labels in Window 

ex sx EX Trace Event 
../ ../ ../ ../ ../ ../ DC DIC# 

../ DQO DRQO 

../ DQl DRQl 

../ DKO DACKO# 

../ DKl DACKl# 

../ EOP EOP# 

../ ../ ../ ERR ERROR# 

../ ../ ../ GAP unavailable 

../ ../ HLA HLDA 

../ ../ HLD HOLD 

../ IN4 INT4 

../ INS INT5 

../ IN6 INT6 

../ IN7 INT7 

INT INTR 

LBA LBA# 

../ ../ LCK LOCK# 

../ ../ ../ ../ ../ ../ MIO MIIO# 

../ ../ ../ NA NA# 

../ ../ ../ NMI NMI 

../ PIO PLO 

../ Pll Pl.1 

../ P12 Pl.2 

../ P13 Pl.3 

../ P14 Pl.4 

../ P15 Pl.5 

../ P16 Pl.6 

../ P17 Pl.7 

../ P20-P24 P2.0 - P2.4 

../ P25 P2.5 
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386 Emulator Trace and Event Window Signals (continued) 

386 Processor Type Mnemonic Labels in Window 

ex sx EX Trace Event 
../ P26 P2.6 

../ P27 P2.7 

../ P30 - P31 P3.0 - P3.1 

../ P32- P35 P3.2- P3.5 

../ P36 P3.6 

../ P37 P3.7 

../ ../ ../ PER PEREQ 

../ ../ ../ RDY READY# 

../ ../ ../ RST RESET 

../ ../ SMI SMI# 

../ ../ ../ ../ SMA SMIACT# 

../ ucs UCS# 

../ WDT WDTOUT 

../ ../ ../ ../ ../ ../ WR W/R# 

Chip Select Registers Saved and Restored for the 386 EX 

CSOADL CS3MSKL PlCFG UCSADL DMACFG 

CSOADH CS3MSKH P2CFG UCSADH INTCFG 

CSOMSKL CS4ADL P3CFG UCSMSKL TMRCFG 

CSOMSKH CS4ADH PINCFG UCSMSKH SIOCFG 

CSlADL CS4MSKL PlLTC 

CSlADH CS4MSKH PlDIR 

CSlMSKL CS5ADL P2LTC 

CSlMSKH CS5ADH P2DIR 

CS2ADL CS5MSKL P3LTC 

CS2ADH CS5MSKH P3DIR 

CS2MSKL CS6ADL 

CS2MSKH CS6ADH 

CS3ADL CS6MSKL 

CS3ADH CS6MSKH 
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Configurable Signals 

With the CPU window Options menu Signals item or the Shell window 
Signals command, configure the following signals to be driven by the 
emulator or from a different source: 

386 486 DX or SX Signal 

ex sx EX SLE non SLE 
./ ./ ./ READY# 

./ ./ ./ ./ ./ RESET 

./ ./ ./ ./ ./ HOLD 

./ ./ ./ ./ ./ NMI 

./ ./ ./ INTR 

./ ./ ./ NA# 

./ ./ ./ Coprocess 

./ ./ ./ ERROR# 

./ ./ ./ BUSY# 

./ ./ ./ PEREQ 

./ ./ A20M# 

./ ./ SMI# 

./ INT0_3 

./ INT4_7 

./ ./ RDY# 

./ ./ FLUSH# 

./ ./ KEN# 

./ SLE 

./ SRESET 

./ SMI# 

./ STPCLK# 
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Signal Loading 

The following lists the typical AC loads in picoFarads (pF) and the 
maximum DC loads in microAmps (uA), besides the CPU load, on 
various 386 EX and 486 signals for low-level (IiL) and high-level (IiH) 
input currents. The actual AC loads measurable with the emulator in 
your target system can differ from these calculated loads. 

Signal 386 EX Loads 486 Loads 

liLuA liH uA ACpF liL uA liH uA ACpF 

Al 11 11 12 

A2-3 11 11 12 10 10 6 

A4-16 11 11 12 ] 1 11 16 

A17 11 11 12 13 13 26 

A18-25 11 11 12 12 12 20 

A20M# 1063 0 8 

A26-31 12 12 20 

ADS# 100 10 5 10 10 6 

AHOLD 10 10 10 

BE0-3# 21 21 22 

BHE# 11 11 12 

BLAST# 10 10 6 

BLE# 11 11 12 

BOFF# 20 20 16 

BRDY# 20 20 16 

BREQ no loads; no CPU load 

BS8# 10 10 6 20 20 24 

BS16# 20 20 24 

BUSY# 0 0 7 

CLK 2410 510 14 

CLK2 100 10 5 

CS6# 10 10 6 

D0-31 10 10 26 

DIC# 11 11 12 11 11 16 

DACKO# 10 10 6 
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Signal Loading (continued) 

Signal 386 EX Loads 486 Loads 

liL uA liH uA ACpF liLuA liH uA ACpF 

DACKl# 10 10 6 

DP0-3 0 0 8 

DRQO 10 10 6 

DRQl 10 10 6 

EADS# 10 10 10 

EOP# 10 10 6 

ERROR# 0 0 7 

FERR# 10 10 10 

FLUSH# 20 20 36 

HLDA 101 11 11 30 30 42 

HOLD 20 20 20 16 

IGNNE# 0 0 8 

INTO 10 10 13 

INTI 10 10 13 

INT2 10 10 13 

INT3 10 10 13 

INT4 1 1 20 

INT5 1 1 20 

INT6 0 0 7 

INT7 0 0 7 

INTR 20 20 36 

KEN# 30 30 42 

LBA# 10 10 0 

LOCK# 1 6 10 10 6 

M/IO# 11 11 12 21 21 22 

NA# 1 20 

NMI 1 1 20 20 20 36 

Pl.0-Pl.4 10 10 6 

P2.0-P2.7 0 0 0 

P3.0-P3.7 0 0 0 
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Signal Loading (continued) 

Signal 386 EX Loads 486 Loads 

liL uA liH uA ACpF· liL uA liH uA ACpF 

PCD 20 20 16 

PCHK# 10 10 26 

PEREQ 0 0 7 

PLOCK# no loads; no CPU load 

PWT 10 10 10 

RD# 0 0 0 

RDY# 30 30 42 

READY 100 10 12 

RESET 101 11 25 30 30 42 

SMI# 1 1 20 1063 0 8 

SMIACT# 11 11 19 20 20 28 

SRESET 30 30 42 

SRXCLK 0 0 0 

SSIORX 0 0 0 

SSIOTX 0 0 0 

STPCLK# 1063 0 8 

STXCLK 0 0 0 

TCK no loads; no CPU load no loads; no CPU load 

TDI no loads; no CPU load no loads; no CPU load 

TDO no loads; no CPU load no loads; no CPU load 

TMS no loads; no CPU load no loads; no CPU load 

TRST# no loads, no CPU load 

UCS# 10 10 6 

WDTOUT 10 10 6 

W/R# 0 0 0 10 10 6 
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Managing the 386 EX Signals 

The following are suggestions for configuring various 386 EX signals: 

RESET is active high synchronized to CLK2. You can pull this 
signal high or low but it must remain stable for 
initialization. This signal can be disabled in the CPU 
window to be driven by the emulator. 

READY# must be synchronized to CLK2 with the proper setup time 
according to Intel specifications for any cycles for which the 
386EX is not programmed. After the chip select unit is 
programmed, such signals include: 

• any unmapped memory or 1/0 space 

• any disabled on-chip expanded 110 space 

• halt or shutdown cycles 

The power-up condition for chip select and ready generation 
allows upper-chip-select memory accesses to the entire 64M 
byte address range. READY# must be tri-stated when the 
386EX provides the ready due to LBA# cycles. READY# 
should have a resistor pull-up to VCC or be pulled low with 
resistor of 600 to 820 ohms for full-time zero wait states. 

NA# must be synchronized to CLK2 and driven according to the 
need for pipelining. Do not float this signal. NA# can be 
disabled in the CPU window to be driven by the emulator. 

BS8# must be synchronized to CLK2 and driven according to the 
actual bus size. Do not float the signal. 

NMI must be driven as needed. When NMI is floated it must be 
disabled in the CPU window to be driven by the emulator. 

SMI# 

FLT# 

HLDA 

must be driven as needed. When SMI# is floated it must be 
disabled in the CPU window to be driven by the emulator. 

must have a resistor pull-up to VCC or be floated when the 
emulator is attached. 

when this signal is configured as an output port, enter 
Config lgnoreHLDA On in the Shell window Command 
Entry pane, to inform the SLD software that the CPU has not 
granted the bus to another master. 
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SAST Schematics 

486 SAST Board 

The following pages contain the EA-486 SAST board schematics. 
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386 CX/SX SAST Board 
The following pages contain the 386 CX/SX SAST board schematics. 
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386 EX SAST Board 

The following pages contain the 386 EX SAST board schematics. 
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Index 

A 

B 

386 SAST board jumpers, 14 
3M, 5, 21 
486 probe jumpers, 15 

AC power source, 15 
adapters 

RS-232C cable, 4, 12 
target, 3-5, 20-22 

Add Event dialog box, 45 
address 

breakpoint, 32 
displaying, 28 
event, 45 
load, 29-30 
Memory window display, 25-26 
numeric, 28 
stack, 37 
symbolic, 28 
trace, 42 

address formats, 28 
address, execution, see CS:EIP 
air circulation, 11 
Always on Top, 24 
Amp,5,21 

blue 
Stack window, 37 

Borland C compiler, 10 
Breakpoint window 

Go To Source button, 34 
opening, 33 

breakpoints 
clearing, 41 
confidence tests, 18, 19 
effect, 34, 42 
setting, 32-33 
summary, 6 
viewing, 33-34 
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Browse Modules dialog box, 29 
Bus Active LED, 16 
bus cycle 

capture mode, 45-46 
trace display, 48 

cables 
adapters, 11-12 
power, 15-16, 20 
probe (ICE), 12 
RS-232C, 11-12 
SAST board, 14 
SAST power, 14 

caution 
386EX probe, 14, 20 
ESD, 11 
power, 13, 16, 20 

chip select registers, 54 
clip-over adapter, 5, 21, 22 
clock cycle 

capture mode, 45-46 
trace display, 48 

code address, 37 
colors 

Stack window, 37 
COMports, 12 
confidence tests 

486 probe jumpers, 17 
command syntax, 1 7 
SAST board, 13, 17 
test descriptions, 17-19 

Config.sys, 9 
contacting Microtek, iv, 3 
CPU registers 

viewing, 27 
CPU window 

CS:EIP, 27 
opening, 27 
Options menu Signals, 55 
SS:ESP, 38 
updating, 34 
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CS:EIP 
CPU window, 27 
Memory window display, 25-26' 
Source window display, 24-25, 31 

cursor 
emulating to, 35 

damage, 13, 14, 16,20 
DC power supply, 15-16 
disassembly 

Memory window, 26 
setting breakpoints, 32-33 
Source window, 27, 42-43, 48-49 
stepping granularity, 35 
trace, 46 
Trace window, 42-43, 48-49 

documentation, see manuals; online help; 
related publications 

EA, 1 
electromagnetic interference, 11 
electrostatic discharge, 11 
email, iv, 3 
Emulating LED, 16 
emulation 

also see stepping 
breakpoint, 34 
features, 5, 6, 7 
Source window cursor, 35 
status, 41, 42 
trigger halt, 46, 47 

emulation control 
triggers, 43, 47 

emulator, see PowerPack emulator 
ESW, see Gold Club 
Event window, 44-45, 51-54 
events 

defining, 44-45 
trace display, 48 
trigger condition, 46 

fax, iv, 3 
features, 5-7 
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firmware, 10 
frame number, 47-48 
Function pop-up menu, 30 
functions· 

finding by name, 28-30 
finding from stack, 37 
load address, 30 
setting breakpoints on, 32 
stack, 37 

Go To Address dialog box 
Memory window, 26, 28 
Source window, 28 

Go To Line dialog box, 30 
Gold Club, 3 

hardware installation 
also see adapters 
confidence tests, 17-18 
host system connection, 11-12 
power supply, 15-16 
probe connection, 12-13 
SAST board, 13-14 
targetconnection,20-22 

Hardware Reference, 1 
help, see contacting Microtek; online help 
host system 

installing emulator, 11-12 
installing software, 9-10 
requirements, 9 

humidity, 11 

ICE cables, 12 
ICE, see PowerPack emulator 
in-circuit emulator, see PowerPack. 

emulator 
ini file, 10 
installation, see hardware installation; 

software installation 
Instruction Mode Assist, 46 
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jumpers 
386 SAST board, 14 
486 probe, 15-17 
confidence tests, 17 

LEDs, 16 
line numbers 

compiling, 10 
finding, 30 
setting breakpoints on, 32-33 

linear address, 28 
Linked Cursor, 43, 48 
Load Complete information box, 38 
loadfile, 10, 23, 38 
local variables, 37 

manuals, 1-2 
memory 

confidence tests, 19 
display formats, 26 
overlay, 6 
SAST board, 14 
tracing accesses, 42 
viewing, 25-26 

Memory dialog box, 25 
Memory window 

CS:EIP display, 25-26 . 
display formats, 26 
Edit menu Go To Addres~·, 25~26, 28 
multiple, 25, 26 
opening, 25 
title bar, 25-26 
View menu Disassetnbly, 26 

Metaware HC toolchiµn; id 
Microtek, i_v,;J ·.: 
modules, 29 ' · __ ;. 

i t11y, 

" 
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online help, 2-3 
overlay memory 

confidence tests, 18-19 
summary, 6 

parameters, 37 
parts, 3-4 
PGA connectors, 3-4 
PharLap LinkLoc 7 .1, 10 
physical address, 28 
pin 1 orientation, 14, 20 
power 

5V or 3V, 5, 14 
cables, 15-16 
emulator, 15-16 
LEDs, 16 
SAST board, 14 
switch, 15-16 
target, 20 
tests, 16 

Power LED, 16 
power source, 15-16 
PowerPack® emulator, 1 
powerpak.ini file, 10 
PP, 1 
probe 

386EX caution, 14, 20 
confidence tests, 17-18 
emulator connection, 12-13 
jumpers (486), 15, 17 
SAST board connection, 13-14 

Problem Report Form, 3 
processor in target, 20-22 
program counter, see CS:EIP 

register variables, 10 
registers, see chip select registers; CPU 

registers; peripheral registers 
related publications, 2 
repairs, 3 
reset 

button, 16 
confidence tests, 18 
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LEDs, 16 
power-on, 16 
target, 14 

return address, 37 

SASTboard 
386EX caution, 14 
confidence tests, 13, 17, 19 
jumpers (386), 14 
memory, 14 
power, 14 
probe connection, 13-14 
schematics, 386 CX/SX, 68-74 
schematics, 386 EX, 75-81 
schematics,486, 60-67 

self-test, see confidence tests; LEDs 
Search dialog box 

Source window, 29 
Trace window, 48 

Selftest LED, 16 
service, 3 
Set Breakpoint dialog box, 32 
Shell window 

icon, 24 
maxBitFieldSize command, 10 
Signal command, 55 
stack commands, 38-39 
Test command, 17 

signals 
386, 52-54 
386EX, 59 , .1 

486, 51-52 
confidence tests, 19 
CPU window Options menu, 55 
event, 45, 51-54 
loads (AC, DC), 56-58 
signal Shell command, 551 
trace, 47, 51-54 

SJl, 13 
SJ2, 13 
SLD™ software, 1, 9 
sockets, 5 
software installation, 9, 10 
solder-down adapter, 5 
solder-down adapter, 21, 22 
source filename, 28 
Source window 
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breakpoint setting, 32 
breakpoint viewing, 33, 34 
breakpoints clearing, 41 
Breakpoints menu Clear All, 41 
Breakpoints menu Set Breakpoint, 32 
Breakpoints menu Show All, 33 
CS:EIP display, 24, 25 
display formats, 27 
displaying variables, 30 
Edit menu Go To Address, 28 
Edit menu Go To CS :EIP, 31 
Edit menu Go To Line, 30, 35 
Edit menu Search, 29 
emulating to cursor, 35 
File menu Browse Modules, 29 
Function pop-up menu, 29 
opening, 24 
Run menu Go To Cursor, 35 
Run menu Step Into, 35 
Run menu Step Into/Over 

Continuously, 41 
source filename, 28 
trace display, 43, 48 
Variable pop-up menu, 30 
View menu Mixed Source and Asm, 

27 
source-level debugger, see SLD software 
source-level debugging 

disassembly, 27 
function display, 28-30, 37 
generating a loadfile, 10, 23 
load address, 29-30 
module information, 29 
source filename, 28 
stack, 36-37 
summary, 5-6 
symbolic addr,esses; ,28-29 
trace, 42-43, 46, 48-49 
viewing source, 24-25 

SS:ESP, see stack.~. , , 
stack 

address, 37 
functions, 37 
loadfile information, 38 
meter, 36-38,'40c41 
parameters,: 37 ; 
registers, 38,c40 
Shell commrutds, 38·39tc 
statistics; 38;:41 
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variables, 37 
viewing, 36 

Stack window 
colors, 37 
contents, 36 
monitoring, 41 
Options menu Enable Alarm Limit, 

40-41 
Options menu Enable High Water 

Mark, 40-41 
Options menu Inspect Source, 37 
stack meter, 36-38, 40-41 
updating, 41 

Status window 
control menu, 24 
emulation status, 41 
icon, 24, 41, 42 
startup, 24 
trace status, 41 
trigger progression, 47 

stepping 
confidence tests, 18 
granularity, 35 
halting, 41 
into a function, 35 
stack monitoring, 41 

SW, 1 
symbolic address, 28 
symbolic debugging, see source-level 

debugging 

target 
386EX caution, 20 
adapters, 21-22 1 ' 

confidence tests;1!19.:• 
connecting to emulator, 20 1 

power, 20 '• · ·' 
processor chip, 20 

telephone, iv, 3 
temperature, 11 
Textool, 5, 21 
Toolbar ·F ,r uiJs:1rx)ln· ;! 

CPU buttdn;.27t'~ ·' 
Go button, 34;·,:i.i, 47'.JE'•t 
gray buttons, 23 
Mern buttonr25 
Show button,'42,,47 
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Source button, 24 
Stack button, 36 
Trigger button, 43 

toolchains, 2, 10, 23 
trace 

address, 42 
bus cycle capture, 45-46 
clock cycle capture, 45-46 
collecting, 41-42, 46 
collection, 4 7 
confidence tests, 17, 19 
disassembly, 42-43, 46 
frame number, 47-48 
memory accesses, 42 
signals, 47 
source, 43, 48-49 
status, 41-42 
summary, 7 
Trace Capture dialog box, 45-46 
trigger position, 45-46, 48 
triggering, 46 
viewing, 42-43, 47-49 

Trace Capture dialog box, 46 
Trace window 

display formats, 42, 48 
Edit menu Search, 48 
signals, 51-54 
View menu Instruction, 42 
View menu Linked Cursor, 43, 48 

trademarks, iv 
Trigger window 

actions, 43 
conditions, 43 
configuring, 43-44 
Edit menu Events, 44 
opening, 43 
Options menu Cascaded Timer, 44 
Options menu Trace Capture, 45 
Options menu with 2 Timers, 44 
screen font, 44 

triggers 
confidence tests, 19 
defining, 46-47 
effect, 47 
position in trace, 45-46, 48 

tri-stating, 5 
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uninstall, 10 
Up & Running, I 
updates, 3 
User's Manual, 1-2 

Variable pop-up menu, 31 
Variable window, 31 
variables 

editing, 31 
inspecting, 31 
register, 10 
stack, 37 

virtual address, 28 
voltage, 5 

warranty, see Gold Club 
web, iv, 3 
Windows 

documentation, 2 
host system requirements, 9 

workstation, see host system 

yellow 
Stack window, 37 
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